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DataView Release Notes –Version 3.52.0009 

 
Released 6-19-2017 

 

CATEGORY Updates (v 3.52.0009): 

Global  

 

New Features 

 
 All control panels now have an option within the connection dialog to show all available 

com ports.  This is to assist in situations where the instrument is not properly identified 
when trying to connect.  The user can now choose to show all COM ports, identify the COM 
port of the instrument and select the correct COM port from the drop-down list. 

DataView Core Version 3.52.0009 

 

Bug Fixes 
 

 Fixed an issue which was causing PEL templates to show worksheets that did not have any 
exported data. 

 Improved functionality of the Tools  Directories function. 
 Fixed an issue which was causing user defined channel units to not display properly on the 

graph. 
 Fixed an issue which was causing scales to not display correctly when being moved to the 

left or right side of the graph. 
 Fixed an issue which caused some graphs to be too focused when the measurement data 

was stable and had little variation. 
 Fixed an issue which caused the horizontal scale to not display correctly if the user changed 

the start/end times. 
 Fixed an issue which caused the “Link Frame” cursor to be persistent when clicking outside 

of the worksheet area. 
Data Logger 

 
Version 2.1.0040 

 

 

New Features 
 

 The Data Logger control panel now only supports the L452 and Environmental Line family of 
instruments.  Support for the Simple Logger II family of instruments has been removed and 
a new control panel, SLII.exe has been created to support that family of instruments 

 The “Save to PC” button to start and end a Record-to-PC recording now has a visual 
indication of when a recording is in process.  This is displayed as a blinking red dot on the 
button.  The control panel will also display a warning to the user now if this type of 
recording is in progress and the user tries to disconnect or remove the instrument. 

 The Simple Logger II family of instruments are now being filtered out of the “Add an 
Instrument Wizard”. 

 Site and Operator information is now exported to Excel. 
 If an instrument is paired to the PC via Bluetooth but is unavailable when the user attempts 

to connect to it, a more appropriate message is now displayed. 
 The Update function in the Help menu now also performs a separate check for the 

DataView version, for cases where the control panel version has not changed but the 
DataView version has.   

 Several improvements to download functionality were implemented to better support 
Bluetooth downloads as well as Pausing and resuming of in-progress downloads.   
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 The control panel will now attempt to check for changes in COM ports at launch pertaining 
to instruments that are already in the tree.  If a change is detected, the instrument will be 
displayed as an available instrument to connect to in the Add Instrument Wizard.  Once 
connected, the instrument will be highlighted in the tree and use the new COM port for 
communication.     

 Improved Memory Usage indication. 
 The DataView Template selection should now default to the Trend Summary Report 

template unless the user manually sets another default template. 
 

Bug Fixes 
 

 Fixed various scaling issues, including scaling issues that occurred due to resizing of the 
control panel window. 

 Fixed an issue which could cause the highlight text for the “Save to PC” button to sometimes 
show incorrectly. 

 Fixed an issue which was causing “Select total duration” to now show the full range of time 
when exporting.   

 Improved functionality of using the “Save to PC” feature on multiple instruments 
simultaneously. 

 Fixed an issue which was sometimes causing the real-time graph to lag behind the 
instrument clock. 

 Fixed various export issues pertaining to date and time stamps. 
 Fixed an issue which would sometimes cause two instances of the same L452 instrument to 

show in the Bluetooth list. 
 General improvements to the handling of user defined scales for the L452. 
 Several improvements to download functionality were implemented to better support 

Bluetooth downloads as well as Pausing and resuming of in-progress downloads.   
 Fixed an error which was causing the Real-Time Meter Display of the L452 to now show the 

values correctly when user-defined scales were being used. 
 Fixed various errors which would sometimes cause exported Excel data values to not match 

the values shown in the control panel. 
 Fixed various errors which would sometimes cause MIN/MAX/AVG data to not display 

correctly in the channel list.  
 Fixed an issue which could cause user defined scales to now be applied correctly when using 

negative scaling. 
 Fixed an issue which was sometimes causing user defined scales to not be applied correctly 

in “Save to PC recordings”. 
 Fixed an issue which was causing the Real-Time graph to still update when the graph was 

paused. 
 Fixed an issue which was causing “Save to PC” recordings to miss some data points.   
 Fixed various zoom issues and made general improvements to zoom functionality. 
 Fixed an issue which was causing the calendar and time interface shown when exporting to 

not behave correctly. 
 Fixed date and time stamp related issues when exporting certain types of recordings to  

DataView. 
 Fixed issues that could occur when printing to PDF-XChange. 
 Fixed an issue which could result in the control panel not re-downloading a recording 

properly when a particular session shared the same parameters as one previously 
downloaded.  
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PAT2 
 

Version 1.4.9938 

 

Bug Fixes 
 

 Fixed an issue which could make it difficult to select the earliest date and time when 
exporting. 

 Fixed a bug which caused the update function to use a cached value for the version number 
instead of checking against the latest. 

 Fixed an issue which was causing NA to be incorrectly displayed for Power and Peak 
min/max values. 

 Fixed an issue which sometimes caused power and energy values in the channel list of the 
graph to not correlate correctly with the same values in the table view. 

 Fixed an issue which caused the start of recordings in the control panel, specifically the 
“Record Now” function, to be unintuitive. 

 Fixed an issue which was causing unnecessary configuration frames to be generated for 
each worksheet when creating a DataView report. 

 Fixed an issue which was incorrectly showing NA for energy data with some recordings and 
also showing inaccurate large power values.   

PEL 
 

Version 2.2.9939 

 

New Features 
 

 The Update function will now correctly utilize the integrated update utility for firmware 
instead of displaying the website URL. 

 The firmware update and firmware check functions are now disabled if no internet 
connection is detected. 

 The automatic firmware check will no longer occur if the user is running the manual 
upgrade already. 

 Modified related templates to show the Report start/end dates/times on the cover sheet 
and the Configuration start/end dates/times on the configuration sheet. 

 Added new and more descriptive hover text for various buttons. 
 The control panel will now check for COM port changes to instruments that are already in 

the network. 
 General UI improvements to facilitate a better user experience. 
 Improved graphical representations of electrical hook-ups. 

 
Bug Fixes 

 

 Grayed out the field for IRD serial number on the communication tab.  Previous 
implementation made it appear as though this field was modifiable when it was not. 

 Fixed an issue which would sometimes cause a loop to occur if the control panel was unable 
to read the version from the internet when using the Update function. 

 Fixed an issue which would cause the control panel to check the memory requirements of a 
configuration when both “Record Now” and “Schedule Recording” were not selected. 

 Fixed an issue which made it impossible to write a configuration to the instrument if the SD 
card was not present. 

 Fixed an issue which could cause the control panel to incorrectly state firmware was up to 
date if the previous attempt to update the firmware with the integrated utility halted or was 
cancelled. 

 Fixed an issue which caused an improper message to be displayed if the configuration 
window was open on one PC while connected via LAN and another LAN connection from a 
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different PC attempted to open the configuration at the same time. 
 Fixed an issue which would sometimes cause the cost for energy to not be applied correctly. 
 Fixed an issue which could potentially cause real-time power data to be incorrect when 

switching between real-time views. 
 Fixed various accuracy issues relating to quadrants. 

PPV 
 

Version 3.07.0038 

 

Bug Fixes 

 

 Fixed an issue which could produce an “Out of Memory” error when attempting to save 

large icp files.   

Megohmmeter 
 

Version 4.02.0042 

 

Bug Fixes 

 

 Fixed an issue which allowed the user to enter custom voltages into the run time window 
when this was not intended. 

Simple Logger II 
 

Version 1.01.0028 

 

New Features 

 

 The Simple Logger II control panel now only supports the Simple Logger II family of 
instruments.  Support for the L452 and Environmental Line family of instruments has 
been removed and is now exclusive to the Data Logger Control Panel. 

 The “Save to PC” button to start and end a Record-to-PC recording now has a visual 
indication of when a recording is in process.  This is displayed as a blinking red dot on the 
button.  The control panel will also display a warning to the user now if this type of 
recording is in progress and the user tries to disconnect or remove the instrument. 

 The L452 and Environmental Line family of instruments are now being filtered out of the 
“Add an Instrument Wizard”. 

 Site and Operator information is now exported to Excel. 

 If an instrument is paired to the PC via Bluetooth but is unavailable when the user 
attempts to connect to it, a more appropriate message is now displayed. 

 The Update function in the Help menu now also performs a separate check for the 
DataView version, for cases where the control panel version has not changed but the 
DataView version has.   

 Several improvements to download functionality were implemented to better support 
Bluetooth downloads as well as Pausing and resuming of in-progress downloads.   

 The control panel will now attempt to check for changes in COM ports at launch 
pertaining to instruments that are already in the tree.  If a change is detected, the 
instrument will be displayed as an available instrument to connect to in the Add 
Instrument Wizard.  Once connected, the instrument will be highlighted in the tree and 
use the new COM port for communication.     

 Improved Memory Usage indication. 
 The DataView Template selection should now default to the Trend Summary Report 

template unless the user manually sets another default template. 
 The Modify Connection function has been removed. 
 The recording mode information (FIFO, XRM, etc.) has now been added to the session 

parameters. 
 When applicable, the range of the instrument is now displayed in session parameters. 
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Bug Fixes 

 

 Fixed an issue which caused event data to not match between “Save to PC” recordings 
and instrument recordings. 

 Fixed an issue which caused the recording duration for XRM recordings to be displayed 
incorrectly. 

 Fixed an issue which caused event data to export improperly to Excel. 

 Fixed an issue which caused Excel to display an “Unreadable content” error when 
exporting specific ICP files. 

 Fixed an issue which would cause the download function to not initiate again if the initial 
download function was cancelled by the user. 

 Fixed an issue which could prevent the user from setting the clock of the instrument after 
erasing the memory. 

 Fixed an issue which caused an available memory check to occur when both “Record 
Now” and “Schedule Recording” were not selected. 

 Fixed an issue which caused the instrument status screen to display improper memory 
information with certain instruments. 

 Fixed an issue which was causing FIFO recordings to be decoded incorrectly by the 
control panel. 

 Fixed an issue which could potentially cause the control panel to crash if more than one 
recording was in the instrument memory and the first recording did not have any data. 

 Fixed an issue which was causing the user defined time in the Report tab of Session 
Parameters to not be saved correctly. 

 Fixed an issue which caused the graph division to display incorrectly after the trend 
buffer was cleared. 

 Fixed an issue which would sometimes cause the scroll bar to disappear when viewing 
table data. 

 Fixed an issue which caused the start and end times for FIFO recordings to appear 
incorrectly when viewing recorded sessions. 

 Fixed an issue which could cause alarm units to not update correctly. 

 Fixed an issue which caused scales to not be applied correctly when performing “Save to 
PC” recordings. 

 Fixed an issue which was causing the real-time graph to continue to update while the 
graph was paused. 

 Fixed an issue which was causing “Save to PC” recordings to miss data points. 

 Fixed several issues pertaining to “Record on alarm” recordings. 

 Fixed various zoom issues. 

 Fixed an issue which was causing the start/end dates/times on the export dialog to 
behave incorrectly. 

 Fixed an issue which could cause the control panel to crash if the memory was full but no 
recording was present (after inserting batteries) and recorded sessions was selected. 

 Fixed an issue which caused missing data when attempting to download an in-progress 
XRM recording. 

 Fixed issues that could occur when printing to PDF-XChange. 
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Previous Releases 
 

 
 

 
 

Ground Tester 
 

Version 1.04.0020 

 
 
 
 

 

Bug Fixes 

 

 Fixed an issue where unnecessary options for certain instrument measurement settings 
were being shown. 

 Fixed a template issue which caused graph scales to sometimes be unreadable in DataView. 
 

  

CATEGORY Updates (v 3.51.0004): 

  

Data Logger 

Bug Fixes 
 

 Fixed an issue that could cause the decoding of XRM mode data to display improperly in the 
control panel for Simple Logger II files. 

 Fixed an issue which was causing the “Save to PC” feature to not function correctly when 
used on multiple instruments. 

  

CATEGORY Updates (v 3.51.0003): 

  

Installation 

Bug Fixes 
 

 Fixed an issue that could cause the DataView version to be set incorrectly in the registry.  
This resulted in some cases of the Update feature in various control panels reporting false 
information. 

  

DataView Core 

Bug Fixes 
 

 Fixed an issue which was causing some files to not open or export correctly to DataView. 
 

CATEGORY Updates (v 3.50.0020): 

  

Installation 

Bug Fixes 
 

 Fixed an issue that would cause the installer to hang if there was not an available internet 
connection.   
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DataView Core 

New Features and changes 

 

 DataView 3.5 has been released.  This version includes a more modern and convenient user 
interface as well as heightened zoom functionality. 

 
Bug Fixes 

 

 Altered the behavior of graph zoom functions under specific circumstances to function in 
a more expected way. 

 Fixed an issue which allowed the user to select dates and times that fell outside of the 
recording period when trimming a database. 

 Fixed an issue which could cause some unit prefixes to be repeated. 
 Fixed an issue which caused DataView to show too much resolution when zooming in. 
 Cleaned various templates to make them easier to read and use. 
 Fixed an issue which caused unit prefixes to appear where they were not applicable. 
 Corrected export errors when sending data from specific control panels to DataView. 
 Fixed an issue which could cause fill-in and graph background colors to appear incorrectly 

when zooming in or out. 
 

  

PEL 

New Features and changes 

 

 Instrument firmware can now be upgraded through the control panel via the 
“Instrument” menu. 

 The “Instrument Panel”, accessed by clicking the “PEL Network” now allows for a limited 
display of real-time values and the ability to configure recordings across multiple 
instruments simultaneously. 

 The export function has been modified to allow for the selection of quantities to be 
included. 

 Highlights have been added to phase angles that are believed to be the cause of phase 
rotation errors.  The highlights are noted by a (*) within the phasor channel list.   

 The SSID of the PEL 105 has been added to the instrument status screen. 
 Several changes have been made to the instrument status screen to improve the user 

experience. 
 The resolution for energy bar charts has been increased. 
 The view of recorded sessions now has columns depicting the type of data present in the 

recordings. 
 When modifying a connection from one medium to an IP medium, the control panel 

should now correctly auto-fill the IP information. 
 The control panel will now prompt the user to save their energy sessions (PEL 105 only) if 

these sessions are open and a close command is issued. 
 There is now no limit to the amount of instruments that are viewable in the Workstation 

view. 
 IRD communication has been improved.  This should result in lower latency when 

communicating through the IRD server.  
 Improved/added IRD error messages to be more accurate as to why registration with the 

server has not completed. 
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 When viewing energy bar graphs, users now have more options for bar width, including  
weekly and monthly options which allow for setting of the day the week begins.   

 

 

Bug Fixes 

 Fixed an issue that produced an error when changing the orientation of the phasor 
diagram. 

 Fixed an issue which was causing the SSID for the PEL 105 to not show correctly. 
 General improvements to the user experience of the download folder dialog located in 

the Tools menu. 
 Corrected 3-phase 4-wire delta phasor diagram to correctly show phase rotation of 

voltage when voltage phasors match reference phasor. 
 Fixed an issue which could cause current neutral harmonics to not update correctly in 

real-time. 
 Fixed an issue where COS and PF values of 1.0 were being incorrectly factored into 

Min/Max/AVG channel list data. 
 Fixed several issues causing non-applicable data to be saved and loaded in configuration 

files. 
 Fixed an issue which caused COS values to not always update correctly while viewing real-

time power. 
 Fixed an error that allowed non-ASCII characters to sometimes be written into ASCII only 

fields. 
 Fixed an error which caused Bluetooth information to show incorrectly on the status 

screen under specific circumstances. 
 General template improvements. 
 Various scaling improvements. 
 Improved the accuracy of the SD card status information. 
 Fixed an issue which could possibly produce an error when closing multiple files within 

the control panel. 
 Fixed an issue wherein the real-time data would not draw correctly if switching quickly 

between instruments. 
 Corrected file size to show accurately in both recorded sessions view and the download 

window. 
 Fixed an issue that caused the real-time view to sometimes not draw correctly when 

switching between AC and DC distributions. 
 Improved the accuracy of the memory usage calculator in the configuration window. 
 Fixed an issue which caused energy bar chart divisions to not correctly align with cursor 

placement. 
 Fixed an issue which could sometimes cause labels of energy bar segments to be 

incorrect. 
 Various improvements to UTC time setting for PEL 105. 
 Fixed an issue which could cause setting the instrument clock to undo previous changes 

in the configuration window before being written. 
 Fixed an error that would allow the user to delete a download folder while sessions from 

that folder were still present in the download window.   
 Improved the accuracy of the Help > Update feature. 
 Fixed an issue which caused the instrument clock to lag too far behind the PC clock when 

adjusting the time zone settings for the PEL 105. 
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 Fixed an issue that allowed recordings of 1 s harmonics when 1 s trend was disabled. 
 Fixed an issue which would cause connection mediums to sometimes not switch correctly 

when modifying a connection. 
 Using the up and down arrows on the keyboard while within the Add Instrument Wizard 

will now behave correctly. 
 Fixed an issue which could rarely cause downloads of recordings to become stuck at 

certain percentages of completion. 
 Fixed an issue which could sometimes cause the control panel to behave incorrectly if left 

open while the PC entered a low power state. 
 Fixed an issue which would cause current sensor parameters to not be written correctly 

under specific circumstances. 
 Fixed an issue which could cause the zoomed state of an open file to carry over to 

another open file. 
 Fixed an issue which could allow for a recording to be configured wherein the recording 

duration was shorter than the aggregation period. 
 Fixed an issue which caused the recording duration on the instrument status screen to 

not always update correctly. 

  

Data Logger 

New Features and changes 

 

 Full feature compatibility with new Environmental Line of instruments models 1821, 
1822, 1823, 1246, 1110 and 1227.  

 Graph functionality has been greatly increased.  Keyboard shortcuts have been 
implemented for zoom functionality and navigating the graph.  Refer to the help file for 
more information. 

 The status screen of the instrument will now show the recording schedule for active 
recordings.   

 
Bug Fixes 

 

 Fixed an issue which could sometimes cause user defined alarm lines to not draw 
correctly on the graph. 

 Corrected various zoom issues related to zoom states of graphs when switching between 
open sessions and the zoom tool function. 

 Fixed various errors in the help file. 
 Fixed an issue which could sometimes cause trend values to not display correctly when 

viewing an open session. 
 Fixed various scaling errors. 
 Decoding of downloaded data and communication for existing instruments should now 

be improved. 
 Fixed various bugs for events with both the L452 and model 404 instruments, including 

the configuration of rising and falling edges for L452 and event accumulation for the 404.  
 Fixed an issues that could sometimes cause an “Unable to communicate with instrument 

error” when erasing memory on some Simple Logger II instruments. 
 Fixed an issue which would allow the user to create a recording where a storage period 

was greater than the duration of the recording.   
 Fixed some inconsistencies regarding start/end date/time and duration of recordings 

being displayed between the session parameters and recorded sessions.   
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Megohmmeter 

Bug Fixes 
 

 Fixed an issue which could potentially cause some parameters to not export to DataView 
correctly. 

 Fixed an issue which could cause default templates to be unable to be selected. 
 Baud rate for Bluetooth specific instruments should now be hidden. 
 Fixed an issue where the second PI value for some tests would not be downloaded from 

the instrument correctly. 
 Fixed an issue which could causes the DAR and PI values to now always be represented 

correctly in the control panel. 
 Fixed an issue which could cause connection difficulties with the model 1060 when 

operating with certain firmware. 
 There was a text string error in the control panel wherein the auto power off feature was 

expressed in reverse.  This has been corrected. 
 Fixed an issue which could cause the Object number of a downloaded session to be 0. 
 Increased resolution for test voltages above 1000V. 
 Fixed an issue which could cause the export to XLS function to not behave correctly. 
 Fixed an issue which could sometimes cause certain instruments to show as “Connected” 

in the control panel after a connection attempt had failed. 
 Changed various strings related to alarms when viewing data in the control panel as well 

as XLS report.  The terminology in these areas now correctly reflects the terminology 
used in the configuration window of the control panel. 

 Improved the handling of corrupted data during download. 

  

PAT2 

Bug Fixes 
 

 Fixed an issue which could cause the recording time of a downloaded session to show 
correctly. 

 Fixed an issue which could cause the export of a photograph to XLS to not behave 
correctly. 

 Improved efficiency of exporting long recordings to DataView. 
 Fixed an issue which caused harmonic graphs to now always match table view data 

correctly. 
 Altered the “Select Template” user interface to make the selection of default templates 

more clear to the user. 
 Fixed an issue which could cause the selection of instrument languages to be blank if the 

configuration window was opened with no instrument connected. 
 Fixed an issue which caused the photographs to not update in real-time when using an 

8333. 
 Fixed an issue which allowed the user to set the instrument clock while a recording was 

pending. 
 Corrected scaling resolution for various current ranges. 
 The icons in the toolbar have been re-ordered to be more consistent and relevant. 
 Fixed an issue which could sometimes cause voltage rations to be unable to set correctly. 
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 Fixed an issue which caused current ratios to sometimes be applied more than once on 
peak values. 

 Fixed an issue which caused the Min/Max button to incorrectly appear when it was not 
applicable. 

  

ICT 

Bug Fixes 
 

 Corrected an error wherein an entry in the pull-down menu for reports reflected the 
wrong specification. 

 Improved the general user experience of the site manager interface which fixed various 
errors. 

 Improved the general functionality of the “Preview worksheet” function which fixed 
various errors. 

 Improved general user experience of editing inspection sheets which fixed various errors. 
 Fixed an issue which could cause data to not be able to be re-downloaded once the 

downloaded session was closed in the control panel. 
 Fixed an issue which could sometimes cause inspection sheets to not be editable. 
 Fixed an issue which could cause the downloading of data to take too long in other 

languages. 
 Corrected various errors with unit scaling when exporting to XLS. 

  

Ground Tester 

 Fixed an issue in which the control panel would not set the buzzer status of the 
instrument correctly. 

 Fixed an issue which could cause tests to download incorrectly if downloaded in 
succession. 

 Various UI behavior improvements, including fields for user-defined distance input. 
 Improved the control panel resolution for user defined distance to more closely match 

the input on the instrument. 
 

CATEGORY Updates (v 3.15.0016): 

  

Installation 

New Features and changes 

 Fixed an issue which was causing the installer to not function correctly. 

 

CATEGORY Updates (v 3.15.0014): 

  

Megohmmeter 

New Features and changes 

 Fully compatible with Megohmmeter Models 6526, 6532 and 6534 

 

  

PEL 

New Features and changes 

 Fully Compatible with Power and Energy Logger Model PEL 105 
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CATEGORY Updates (v 3.15.0013): 

  

Data Logger 

 Fixed an issue which could cause multipliers for certain instruments to not function 
correctly. 

 Fixed an issue which could cause an error if an open session was re-downloaded from 
within the control panel. 

 Minor UI improvements. 

  

PAT2 

Bug Fixes 
 

 Fixed an issue which was causing the “Create DataView Report” option to be enabled 
while within the real-time view. 

 Fixed an issue where the control panel would sometimes incorrectly report that another 
recording was in progress when attempting to schedule a new recording. 

  

PEL 

New Features and changes 
 

 If “Resume download when control panel starts” is turned off and downloads are paused, 
a message will be presented to the user to inform them that downloads are waiting to be 
resumed.   

 PEL control panel will now check for valid firmware when an instrument is added to the 
PEL network. 

 If the user is viewing a recording from an SD card with a SD card reader, the card is 
removed and the user tries to manipulate or view the recording from within the control 
panel, the user will now be given an error. 

 The error “Unable to open Com Port” is now a modal dialog. 
 

Bug Fixes 
 

 Fixed an issue which was causing non-applicable connection options to show when 
modifying connection to PEL 102/103. 

 Fixed an issue where by setting the clock for a PEL 102/103 would sometimes use a time 
zone offset.  

 Improved scaling for PEL 105 unbalance information 

 Fixed an issue which could sometimes cause voltage ratios to show improperly on the 
status screen. 

 Fixed an issue which was causing non-applicable instruments to show as needing a 
firmware upgrade. 

 Fixed an issue where quadrant fields would appear mislabeled in session parameters. 

 Fixed an issue where energy session parameters were showing an inaccurate sensor 
range 

 Fixed an issue which was causing the time zone offset for PEL 105 to not be applied 
correctly. 

 Fixed an issue which was causing the reset of energy recordings in the PEL 105 to not 
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behave correctly. 

 Fixed an issue where voltage ratios could sometimes be below acceptable values. 

 Fixed an issue which was causing the template selection portion of the new “Select Data 
to Export” dialog to behave incorrectly. 

 Fixed an issue which could sometimes cause improper parameters to show for a neutral 
probe when viewing recording status. 

CATEGORY Updates (v 3.15.0012): 

 
 
 

DataView Core 

 Fixed an issue which was causing incorrect characters to show when exporting to spread 
sheet. 

 Fixed an issue which caused Window MIN and MAX to not be checked for Non-applicable 
values. 

 Fixed a scaling issue which could sometimes cause RMS data to not show correctly. 
 Added new instruments to the to the instrument control panel list. 
 Added template associations for DL.exe. 
 Fixed an issue which could cause DataView to sometimes handle file extensions 

incorrectly. 
 Added a page outline when selecting New from the File menu. 
 Improved the handling of events within DataView. 
 Fixed an issue which would cause frames to overlap when enabling and disabling 

scrolling. 
 Adjusted some templates to include an additional Units column for certain frames to 

make data easier to discern. 
 Fixed an issue which could cause resolution inconsistencies between some frames. 
 Fixed an issue which could sometimes cause graph outlines to default to white. 
 During installation, Dataview will now check for a new version. 

  

Ground Tester  Added translation for the Spanish help file. 

  

Megohmmeter 

New Features and changes 

 Added support and functionality for Megohmmeter models 6532, 6526 and 6534 
 Added functionality for selection of templates to default to the appropriate model based 

on the ICP file being exported 
 

Bug Fixes 

 Fixed an issue which could cause the data frame of the control panel to not always 
display correctly 

 Fixed an issue which allowed for multiple instances of the control panel to be opened 
simultaneously 

  

Ground Clamp  Fixed an issue which would sometimes cause the toolbar to appear incorrectly. 

 
 

DTR  Added a Default Template feature. 
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Micro-ohmeter 

 Added Deutsch as a language selection to support new firmware versions. 

 Fixed alignment of some selections in configuration. 

 Fixed an issue which could cause the display in the control panel to not change correctly 
when opening a new file. 

 Fixed an issue which could cause greyed out or non-applicable fields to be checked and 
verified. 

  

Simple Logger II 
– Now Data 

Logger 

 The Simple Logger II control panel has been removed from this release.  We have 
introduced a new Data Logger Control Panel, DL.exe.  DL.exe will support all Simple 
Logger II instruments as well as the new L452 Data Logger.  This new control panel 
consists of an updated and more modern user interface, as well as new features for the 
L452. 

  

PAT2 

New Features and changes 

 

 Cancelling a spreadsheet export will now cancel all future saves instead of asking for a 
confirmation for each individual save. 

 Various improvements to templates. 

 Selecting File>Open will now remember the last path used. 

 Selecting “Record Now” from the configuration and then selecting “Ok” will now 
immediately activate a Trend recording without having to schedule and input times.  In 
addition, “Use same dates” check box is no longer available when “Record Now” is 
selected. 

 Events for Dips, Swells, Interruptions and RVC concerning EN50160 tests are no longer 
considered failures of the entire test.  Only slow variations out of set limits are 
considered failures of the entire test. 

 Improved scaling of harmonics when viewing photographs. 

 Included a new sample file. 

 “Select Report” has been renamed to “Select Template”. 

 Graph cursor will now show duration when viewing a graph with more data points than 
pixels.  The cursor will show how many data points (in a time interval) are behind the 
cursor. 

 Peak values are now displayed in the control panel. 

 When exporting a large file to DataView, configuration information is now available for all 
files. 

 When exporting large files, division into separate files is now done automatically with a 
text indicator as an identifier. 

 The status screen will now inform you if the instrument is accumulating energy. 

 Instrument serial number will now be shown in the status screen. 

 Changed template to automatically adjust start/stop date/time. 

 Adjusted checks performed for sensors and ratios. 

 Increased resolution when displaying wattage. 

 Cost feature has been added for energy with accompanying sheet for the DataView 
template. 

Bug Fixes 
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 Corrected display of energy units. 

 Fixed an issue which could cause the Print Preview feature to not correctly show what 
was in the data frame. 

 Fixed an issue which could cause a warning message to repeatedly appear when the 
configuration window met certain conditions. 

 Removed MIN/MAX buttons for screens where the feature was not applicable. 

 Removed units for PST and PLT worksheets. 

 Fixed an issue which could cause the download of an EN50160 test to disconnect the 
control panel from the instrument. 

 Fixed an issue which could cause the scale of a graph to be drawn incorrectly when the 
control panel window was resized. 

 Fixed various zoom issues. 

 Fixed an issue which was causing harmonics to scale incorrectly when the hide 
fundamental option was turned off. 

 Fixed various issues regarding bar graphs for energy. 

 Fixed an issue which could cause the data resolution of Inrush to be too low when 
exporting to spreadsheet. 

 Fixed a formatting issue which could cause spreadsheet columns to be too narrow to see 
some digits. 

 Fixed an issue which could cause some power values to not export to DataView correctly. 

 Fixed various export issues and improved functionality of the export feature, particularly 
when exporting large recordings. 

 Fixed an issue which was causing the “Select Start and End Time” feature to not always 
behave correctly. 

  

PEL 

New Features and changes 

 

 Added support for model PEL 105. 

 Improved speed of writing configuration to PEL 102/103. 

 Added more thorough filter options when exporting data to DataView and spreadsheets. 

 Graph cursor will now show duration when viewing a graph with more data points than 
pixels.  The cursor will show how many data points (in a time interval) are behind the 
cursor. 

 When viewing power factor, the default selection will alter for source and load 
depending on the values.  If PF values for load are # # #, or not applicable, the view will 
default to source and vice versa. 

 Exporting to DataView from the PEL control panel from a fresh install will now default to 
the basic template instead of showing the Select Template dialog. 

 Adjusted the “Select Start/End Time” feature.  If a selection is made using this feature, 
the export window will now also use the same time/date selection. 

 Added a feature to allow for inversion of current sensors. 

 Added a reference phasor for the 1-phase 2-wire distribution system. 

 Adjusted several phasor diagram measurements to be more accurate. 

 Changed the default view for harmonic data to harmonic 3. 

 Overall improvements to downloading. 

 Improved general formatting of data. 
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 Various improvements to Session Rates. 

 Added “Workstation” view. 

 Improved functionality of the “Add Instrument Wizard”. 

 Improved handling of large event logs. 

 Set the minimum duration of the schedule recording function to 1 hour. 

 The export dialog will now default to the start and end date/time of the zoomed period 
of the current display. 

 An “Energy Balance” page with accompanying bar chart has been added to the “Session 
Totals/Total Energies and Costs” section of open PEL 105 recordings in the control panel. 

 Various improvements to the PEL DataView templates. 

 Improved searching for instruments on a network. 

 “Select Report” has been renamed to “Select Template”. 

 Spreadsheet exports with worksheets that are created for continued data within one 
workbook now have headers on each worksheet. 

 The “Select Data to Export” dialog UI has been changed to allow for template selection 
when exporting to DataView from the PEL control panel.   
 

Bug Fixes 

 

 Fixed various export issues including date/time, export of AC/AC+DC measurements and 

data resolution.  Also addressed inconsistencies between screens which show start and 

end times within the control panel and DataView, including measurement screens, 

recording durations and the export dialog. 

 Fixed several formatting issues in real-time measurements. 

 Fixed an issue which could cause data to be portrayed incorrectly if the control panel 

window had been resized. 

 Fixed an issue which was stopping the print preview feature from showing exactly what 

was shown in the data frame. 

 Fixed an issue which could sometimes cause energy values and energy bar charts to show 

incorrectly in the control panel. 

 Fixed an issue which could cause 1 s data to scale incorrectly when zooming. 

 Fixed an issue which could cause the “Select Start and End” feature to not function 

correctly. 

 Corrected real-time phase angles for several distribution systems. 

 Fixed an issue where a PEL with a password would not have its clock set when selecting 

Instrument > Set Clock. 

 Fixed an issue which could sometimes cause downloads to be suspended when they 

should not be. 

 Fixed an issue which could cause unwanted fields to change when loading configurations. 

 Fixed an issue which could sometimes cause the control panel to get “locked” in a 

recording state. 

 Fixed an issue which could sometimes cause an impossible value to be shown for Power 

Factor measurements. 
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 Fixed an issue which could sometimes cause the status screen to not draw correctly when 

switching between instruments in the PEL network. 

 Fixed an issue which could sometimes cause the control panel to say an instrument has 

changed when it has not. 

 Fixed an issue in which cursor average values were showing to be higher than cursor max 

values. 

 Fixed an issue which was causing Session Properties Site and Operator fields to behave 

incorrectly. 


